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Document Scope
This is a user manual for the SediMeter™ software, version 2.0. It is intended as a

reference to assist users in getting the most out of the software. It is, however, not

exhaustive, as the application inherits many features and shortcuts from its development

platform (LabView) that are not documented here. Right-clicking on different parts of the

user interface brings up context sensitive menus that provide a wealth of options that are

beyond the scope of this manual to document.

Document Version
Present version rev. 2.0, 2009-05-06.

Previous version rev. 1.1, 2008-05-13.

Software Scope
SediMeter.exe is the communication and data management application for SediMeter and

LogDator instruments. Version 2.0 supports instruments with model number SM2-0004

and up (earlier models should use software version 1.0 to get a correct temperature value).

Supported Operating Systems
The application has been tested under XP SP2 and Vista, but is designed to also run under

Windows 2000.

Drivers
The communication with the SediMeter instrument can be either by USB or RS-485. To

use USB the drivers from Silabs have to be installed. To use RS-485, the computer must

have either a RS-485 port, or an adapter, e.g. a USB to RS-485 adapter, in which case

drivers for that adapter must be installed. Links to the latest USB driver updates are

available at www.lindorm.com/downloads, and may need to be installed if the operating

system is upgraded in the future.

Legal Notices

Copyright
This manual, as well as the application it refers to, is ©Lindorm, Inc., 2006-2009. All rights

reserved. Contact copyright@lindorm.com to request permission to use the material.

Warranty
This software is supplied on a site use license basis. No express or implied warranty is

made regarding the usefulness for a specific purpose, beyond to communicate with

Lindorm’s SediMeter and LogDator instruments.
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Installation
Insert the CD and follow the instructions. Do not change the default directories, as it may

prevent the software from working properly. You will get warnings that the software has

not being certified; this is normal (it would be cost prohibitive to certify the software, since

every time a minor update was made it would have to be re-certified).

Installing USB drivers

Locate the setup file identified in the ReadMe document, and double-click it. Again, you

may get warnings (at least under Vista) that the drivers have not been certified; this is

normal.

USB drivers are not required for using the software with SediMeter instruments that do

not support USB.
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User Interface Reference

SediMeter Control window

When starting the application the SediMeter Control

window appears. The Connection tab is open, and the

other tabs are inaccessible.

Front panel objects

Connection tab

Serial Port pull-down menu

Select the COM port the SediMeter is connected to.

Use the Refresh option if you connect a SediMeter

when the application is running.

Interface switch

Select USB (default) or RS-485 depending on how

you have

connected the

SediMeter. If

you select RS-

485 a new

control will

open, Baud

Rate. However,

at the moment

only one baud rate is supported (9600 baud), why it

just serves as information.

Open Connection button

Click to open the serial port. When you do (and

there is no error), the remaining tabs get unlocked,

and the footer of the window becomes un-dimmed.

Window Footer

Send To selector

Every message that is transmitted starts with a one-

byte address code, the NetAddr (aka RS485 ID). A

value of 0 (zero) signifies a broadcast to all
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connected instruments. A value of 1 to 255 is used to address a specific SediMeter.

Use 0 for USB and for broadcast commands in RS-485. However, to get a reply from an

instrument in RS-485, you must enter that SediMeter’s NetAddr in the Send To field (in

USB the SediMeter will reply even if the command is sent to 0; however, if you have

NetAddr 1 connected, and enter any value other than 0 or 1 in this field, the SediMeter will

not respond and you will get an error message).

Reply From indicator

When a SediMeter responds, this field will indicate the NetAddr of the instrument that

responded. This may be useful in USB mode, when you can have several SediMeters

connected at the same time to different COM ports. Use this field to know which one you

are communicating with at the moment. (You must disconnect and re-connect to another

COM port to change which one you communicate with.)

Setup tab

Computer Time indicator

 This indicates the present date and time that the

computer is set to, in ISO style format and in the UTC

time zone (corresponding to GMT, the time at 0º

longitude). [The SediMeter also uses the UTC time

zone; although there is an option for setting the local

time zone in the instrument, there is at present no

software control for changing that setting.]

SediMeter Time indicator

This indicator is dimmed until the time has been read

from the SediMeter. Changing the Send To selector

dims it again.

dt (s) indicator

When the SediMeter clock is read the difference

compared to the computer clock is calculated, and the

number of seconds is shown in this indicator. A

positive value means that the SediMeter is ahead of

the computer clock.

The SediMeter time may be set to within 0.02 s by

this software, but due to drift the difference increases

with time. You may want to record this value when

downloading data. You can click the end values and

change them to adjust the scale (e.g., from –1 to 1 s), if required.
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Dual function controls / SediMeter indicators

When you open the Setup tab default values will be shown in the fields Start Time,

Interval, Burst Rate, and Samples. You can edit these values. Whatever is in these fields

when you click SET (see below) will be sent to the SediMeter(s). When you click GET (see

below) the present setting of the selected SediMeter is retrieved and presented in these

fields.

Start Time control/indicator

The start time for self-timed logging in the format hh:mm:ss. The next time that the

SediMeter clock reaches this time, and it is in Logging Mode, it will start logging. Each

time a measurement is made, this setting in the SediMeter will be increased by the amount

specified as the Interval.

Example: If the time is 15:30 on a Monday, and you want the SediMeter to start logging

at 00:00 on Wednesday, enter 00:00:00 in this control and set the SediMeter to Sleep Mode.

Then some time on Tuesday (between 00:00:01 and 23:59:59) change the SediMeter mode

to Log Mode.

Interval control/indicator

The interval between measurements in hh:mm:ss. The minimum value you can set is 1 s.

However, the capacitor that provides the SediMeter sensor with power needs at least 2

seconds to re-charge, if fed by the standard two 3.6 V batteries. Use short measurement

intervals at your own risk. If the white LED shines visibly less bright at the second and

following measurements, the interval is certainly insufficient.

Burst Rate control/indicator

The interval between sampling of the two optional sensors within one and the same

measurement. The unit is 1/32768th s, the rate of the SediMeter clock crystal. The range is

X ! Burst Rate ! 65535, where X depends on the optional sensors (refer to the instrument

documentation). If the checkbox underneath is unselected this value will not be updated in

the instrument.

Samples control/indicator

The number of burst samples to take per measurement. The range is 0 ! Samples ! 84. If

the checkbox underneath is unselected this value will not be updated in the instrument.

Frequency indicator

This indicator converts the Burst Rate value to a frequency value in Hz. The range is 50 "

Frequency " 0.5 (corresponding to the Burst Rate range given above).

SET button

When clicking this button, the SediMeter selected in the Send To field is programmed with

the values presently in the Computer Time, Start Time, Interval, Burst Rate, and Samples

fields. If using the RS-485 protocol with more than one SediMeter is connected, selecting 0
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in the Send To field causes all connected SediMeters to be exactly synchronized by this

command.

GET button

When clicking this button, settings are downloaded from the SediMeter selected in the

Send To field (which may only be left as 0 if using USB). The SediMeter Time, Start Time,

Interval, Burst Rate, Frequency, Samples, Reply From, and dt (s) are all updated as a result.

Download tab

This tab deals exclusively with the built-in 2 MB flash

memory. (For memory card operation refer to the

SediMeter Instrument Manual.)

The Send To and Reply From fields work as

before. Broadcasts over the RS-485 link are not

supported for any action on this tab.

Checking the memory usage

A number of controls and indicators work together for

checking the memory.

CHECK button

Click this at any time to request information from the

SediMeter and update the associated indicators (this

command is never sent automatically).

SediMeter Memory Usage indicator

This refers to the 2 MB (4096 records of 512 bytes

each) built in memory. Blue color indicates new data,

whereas red color indicates “read” data. Data may be

marked as read by several ways: By being downloaded

(read); by being discarded from this tab (see below);

by the SediMeter being Reset (using the Reset button

on the PCB, or by being without power for a number

of minutes); or by using the SediMeter NavPin user interface to mark it as read.

Total Records indicator

The number of 512-byte records currently in the internal memory. Since memory is being

used in a round-robin fashion there may be room for new data even if this shows 4096.

New Records indicator

The number of records that have been recorded but not yet marked as read. When this value

reaches 4096 the memory is considered full, and the SediMeter will cease measuring.
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Next to Read indicator

This is a pointer maintained by the SediMeter to the next record that has not yet been read,

with a range of 0 to 4095.

Save-to File control

The full path and file name (including extension) for where to save data to be downloaded.

Although you may type in the path and filename, it is probably easier to use the browse

button (with the folder icon on it).

Enter a path and file before clicking on any of the download buttons below this field.

Get New button

Clicking this button downloads the new (un-read) records from the selected SediMeter to

the indicated file. Download starts with the record that is “Next to Read”.

After the download is finished a new window opens with the raw data. There is no need

to click Save in that window; the data has already been saved to the file, so you may just

close it after verifying that the data has arrived as expected.

Get All button

Clicking this button downloads all records from the

selected SediMeter to the indicated file. Download

starts with the first record, number 0.

After the download is finished a new window

opens with the raw data. There is no need to click

Save in that window; the data has already been saved

to the file, so you may just close it after verifying

that the data has arrived as expected.

If the memory has been recorded in a round robin

fashion, the file generated will not contain data in a

strict chronological order. It is possible to restore

order by making a copy of the file, and deleting the

older end from one, and the newer beginning from

the other.

Discard button

This marks all records in the SediMeter memory as

“read”. It does so by changing the “next to read”

pointer to the same value as the internal “next to

write” pointer, thus simulating a Reset. Use this

button to discard data without erasing the memory.

The internal memory is flash, and it has a limited

lifetime in terms of read and write cycles. To prevent

premature failure of the first page of memory, the



Lindorm Inc. LINDORM.COM

SOFTWARE MANUAL 2.0.DOC 2009-05-06 PAGE 10 OF 37

round robin memory method may be used. It is very unlikely that the lifetime will be

reached in this application anyway, so this is just an added precaution.

Erase button

This erases the built in flash memory (or rather, the data in it). A red indicator appears

during the erasing. When done, which takes around a minute, the red indicator turns green

(see illustration). As mentioned, the memory usage indicators do not change automatically;

click CHECK if you wish to double-check that erasing was successful.

Note that there is no Undo on the Erase command. Be careful not co click it by mistake!,

since it does not ask for confirmation before executing.

Special tab

If you are connected to a remote SediMeter, be cautious when changing mode as you risk

losing communication in such a way that you would have to cut power for up to an hour to

re-establish communication (or retrieve it, if it has batteries installed).

SediMeter Mode control/indicator

Select the mode for the SediMeter. In Sleep and

Logger modes RS-485 is off, in the remaining three

modes it is on. Changing to Logger mode causes a file

to be written to an installed memory card. Changing to

Master mode causes a sub-directory with files to be

written to the installed memory card (if no card is

installed, it will revert back to the previous mode).

Adapter mode is only appropriate if connected by

USB.

If the setting is changed to Logger or Sleep wile

connected by RS-485, the connection will be lost

when the SET button is clicked.

RS-485 Baud Rate
control/indicator

At present only 9600

baud is supported (and

always 8 data bits, 1

stop bit, and no parity).

(Yellow) SET button

Clicking this button sends the values of the mode and baud

fields to the SediMeter selected by the Send To field (or to the entire RS-485 network if

Send To equals 0). It is recommended to send to one instrument at a time, since that makes

it possible to verify the change. The Success indicator turns red and the mode setting

reverts if the change is not accepted.
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GET button

Clicking this retrieves the mode and baud rate setting from the selected SediMeter and

updates the respective fields.

New NetAddr control

This changes the NetAddr (aka RS485 ID) in the instrument. Each instrument on an RS-

485 network must have a unique number. Since instruments are identified by their NetAddr

in memory card file names, it is recommended to set this value once and for all at the time

of acquiring a new instrument. The default is the last two digits of the serial number.

To use, enter the new and unique NetAddr here (range: 1 ! NetAddr ! 255).

(Red) SET button

Click to change the NetAddr in a SediMeter. The usage depends on how you are connected,

as follows. The new number remains even after a

Reset.

USB: Enter the New NetAddr and click SET. The

Reply From will say 0, since no reply is sent. Click

the green GET button to update the Reply From

field, and verify success.

RS-485: Enter the New NetAddr in the appropriate

field, enter the old NetAddr in the Send To field, and

click SET. The Reply From field will say 0, since no

reply is sent. Enter the new NetAddr in the Send To

field and click the green GET button to update the

Reply From field, and verify that communication

works. WARNING: Do not issue a change NetAddr

command with 0 in the Send To field if more than

one instrument is connected.

Monitoring tab

This tab contains a checklist of things to do to start

real time monitoring. Note that to start recording to

file you must also press the record LED in the Data

window—specifying a file is just step 1.

Save to File control

Select path and file for where to store the data

collected during real time monitoring. Click on the Browse button, or type in the path and

file name.
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Extra Delay control

If you get an error message during real time monitoring that the reply did not arrive in time,

first verify that the instrument is listed in the NetList, and that it responds to commands

such as clicking GET in the Setup tab. If the error persists, you can enter a delay in this

control. It causes the software to wait this many seconds extra before requesting data. (If

this solves the problem there is a bug either in software or firmware, since the

communication protocol normally should handle the timing.)

Menus

File menu

Open…  Ctrl+O

Opens a window called untitled.sm2 without any data (see “*.sm2

window” below). Use the menus in that window to actually open

a data file.

Exit  Ctrl+Q

Quits the application.

Edit menu

Cut  Ctrl+X

Removes the selected text from a field

and places it in the clipboard.

Copy  Ctrl+C

Creates a copy of the selected text in

the clipboard.

Paste  Ctrl+V

Creates a copy of the text in the

clipboard in the selected field at the

place of the insertion cursor.

Raw Data…

Opens the *.sm2 window (see below) with the data presently in memory. If there are no

data in memory, it opens as untitled.sm2, just as if selecting “File -> Open…”.

SediMeter List…

Opens the SediMeter List window, for editing the list of connected instruments (see below).
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Display Units…

Opens a window for defining conversion factors from one physical unit to another using a

simple linear formula of type y = a + bx for data from optional analog sensors such as light

and pressure (see below).

Advanced > Calibration File…

Opens the SediMeter Calibration Coefficients window (see below). This is intended for

instruments that report raw binary data that have to be converted to physical units in

software (including SediMeters with firmware up to rev. 1.4).

Advanced > Recalibrate Instrument…

Opens the Recalibrate Instrument window (see below). This is intended for instruments that

report data in physical units (including SediMeters with firmware from rev. 2.0, although

the feature can be overridden so that the calibration file option can be used instead). The

Recalibrate window is password protected so that only certified personnel can change the

calibration.

Advanced > Monitor Communication Port…

The window that opens is intended for debugging an RS-485 network with a master and

one or more slaves. The software passively displays the data on the communication port.

Data menu

Analyze Logged…  Ctrl+A

Opens the SediMeter Data window (see below) in

post-processing mode. This menu item is disabled

until some data have been opened, either through

download, *.sm2 file open, or *.ld2 file import.

Monitor Real Time…  Ctrl+M

Opens the SediMeter Data window (see below) in

real-time monitoring mode. The measurement interval, burst rate, and number of samples

are all taken from the respective fields in the Setup tab. Measurements start immediately,

and are timed by the computer, but the time recorded in the file is the time of the SediMeter

clock.

Follow the checklist under the Monitoring tab prior to selecting this menu item!

Inverted SediMeter

When this item is set, the SediMeter Data window plots the data from the sedimeter optical

backscatter array upside down, with detector #1 highest and #36 lowest (in real-time

monitoring this setting can also be changed in the data window itself). If you have collected

data with an instrument mounted upside down, e.g. with the logger house buried in the
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bottom, set this before selecting Analyze Logged... so that the bottom level will be

interpreted correctly.

Web Server

This item turns on and off the web server on the default port. A checkmark indicates when

it is on. Do not turn it on if another application on the computer is running a web server (or

any other process) on that port.

When on, the web server presents the SediMeter Data window as an image,

automatically updated every 60 seconds. The page can be viewed from any web browser by

entering the domain or IP of the computer in the browser address field. For instance, if the

IP is 192.168.1.100, type http://192.168.1.100 to view the web page.

The actual document is C:\Lindorm\SediMeter\www\SediMeter.html (provided that C:

is the Windows volume). You can edit that document in a text editor to put in your custom

information before and after the SediMeter Data window.

Window menu

The content of this menu is a list of the currently open windows of the application. Note

that in some cases you may need to close one window in order to access all features of

another window.

Help menu

Show Tip Strips  Ctrl+T

Turns off or back on the tip strips that appear when you idle the mouse above a control or

indicator. They are on by default.

Show Context Help  Ctrl+H

Turns on or back off a context-sensitive help window. It displays more in depth help about

the items you idle over with the mouse, than the tip strips provide. This is off by default.

About…

Shows the About window. Click anywhere in it to close it.

File window (untitled.sm3)

This window gives access to the raw data files, type *.sm3 (it can also open files from

version 1, with extension *.sm2). You may close this window but the data set remains in

memory until you select Open... from the Control window, download another data set, start

real time monitoring, or close the application.

Front panel objects

An *.sm3 file may contain data from a single instrument, or from an entire network of up to

255 SediMeters (including data from LogDators without sedimeter sensors). For each
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instrument there is one record per

measurement. This creates a 2D matrix

of measurements, which occupies the

main portion of the front panel. The

right hand side of the window

represents a single record.

Record selector

Use this to step through the records

from one and the same instrument. To

find the last record, right-click in the

white field to open a context-sensitive

menu and select “Show Last Element”.

Instrument selector

Use this to step through synchronous

records from different instruments

(such as created by a real-time RS-485

monitoring network).

Cluster indicator

Each record is a cluster of various

elements. This is an indicator, meaning

that the data are not editable. The only

possible edit in this window is to

remove records from both ends (see

below). This is by design, so as to

preserve data integrity.

 The content of a data record is

described in the following.

NetAddr

The NetAddr of the SediMeter (known as RS485 ID in the LogDator display).

Flags

These 8 binary flags indicate the setup and options of the SediMeter. Bit 0 indicates that

the time is in UTC. Bit 4 indicates the data format of firmware rev. 2 (data converted to

physical units). A value of 00010001 thus indicates a no-error condition.

Start Time

This is the time of the (start of the) measurement.
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Temperature (cK)

The temperature measured by the built-in sensor, in cK (centikelvin). Divide by 100 and

subtract 273.15 to convert to ºC (degrees Celsius).

Potential (mV)

The voltage measured over the storage capacitor at the end of the measurement when the

voltage is at the lowest. For a SediMeter the normal value with new batteries is 6 V. If the

value falls below 5 V the sedimeter turbidity accuracy is affected, but level measurements

are still possible.

Interval (clockcycles)

The interval in 32768ths of seconds for the optional sensors in the AIData table.

SMData

A table with SediMeter data, 2 columns with 36 rows. The top row is OBS #1, i.e., the

lowermost optical backscatter detector. The left column is the measurement with the LED

off in firmware rev. 1, the FBU value in firmware rev. 2. The right is the measured signal

with the LED on. The values are 16-bit hexadecimal values, 0000 ! x ! FFFF, where 0000

represents 0 V and FFFF represents 2.5 V for the Uoff and Uon values.

AIData

A table with optional sensor data, 2 columns with 0 to 84 rows. The top row is the first of

the optional burst samples. The left column is channel A6 (usually pressure), the right A7

(usually light). The values are 16-bit hexadecimal fix values, corresponding to the mantissa

and optional sign bit of a float number.

AI6format, AI7format

This is a one-byte value that indicates the coding of the AIData. Bits 0 to 6 correspond to

the exponent of a float number, and bit 7 indicates if it is a signed number. (This can be

changed from the Recalibrate Instrument window.)

AI6units, AI7units

This is the unit of the AIData. It can be up to 3 characters long, and is displayed in the Data

window. The units can be changed in the instrument from the Recalibrate Instrument

window, and also overridden at display time using the Display Units window.

Records

The total number of records.

Volt meter

This indicates the minimum voltage in all the records. If this value falls into the red area for

a SediMeter, it may be a good idea to replace the batteries before any new deployment.
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Status

This indicator currently has no use.

LogData Path

The full path and filename of the present data.

Menus

File menu

Open…  Ctrl+O

Use this to open a previously created *.sm2 file.

Merge…  CtrlM

This is currently not in use.

Save  Ctrl+S

Saves the current data to the same file as last time. Use

this to save the data after removing any records that

represent measurements before the instrument was

deployed, or after it was retrieved.

Save As…

Opens a browser dialog for picking a new path and file where to save the current data.

Import LogDator File…

Use this for importing data from an *.LD2 file. In the *.LD2 file format the NetAddr is

assumed to be characters 6 and 7 in the file name, in hexadecimal notation. If you must

rename the file then leave those two characters intact, lest the software potentially

misinterpret the data (notably with unit conversions).

A LogDator (or SediMeter) storing data on a memory card in Logger mode uses the

*LD2 file format. It is also used by a master (i.e., a network logger) storing data from a

slave that is a SediMeter or LogDator. (The master simply writes the data from the slaves to

the memory card; the slaves are entirely responsible for the file content and extension.)

Export Text File…

This command exports the SediMeter data table as a tab-delimited ASCII file (in decimal,

not hexadecimal, number format). Column one is the 16-bit value when the LED is off in

firmware rev. 1, or the FBU value in firmware rev. 2. Column two is the value with the

LED on. Row one is OBS #1, row 36 is OBS #36, of the first measurement of the first

SediMeter.
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If there are more than one instruments in the *.sm3 file, the first measurement of all the

instruments are first output, before the second measurement of the first instrument. These

successive data are output in the following rows, so that the generated file will have 2

columns, and [36 times number of instruments times number of measurements] rows.

Close  Ctrl+W

Closes the window (while keeping the data in memory).

Edit menu

Cut, Copy, and Paste function as

previously described.

Delete submenu

First Record  Ctrl+F

Deletes the first record (with index 0).

Last Record  Ctrl+L

Deletes the last record. To commit the

changes to disk, select Save or Save As.

Window menu

The Window menu functions as previously described.

Help menu

The Help menu functions as previously described (although Show Tip Strips is not

presently implemented in this window; the workaround is to turn them on or off in the

SediMeter Control window).

SediMeter List window

When the application is started it reads the contents of the file

C:\Lindorm\SediMeter\SM_Network.smnt. The contents of that file can be inspected and

edited in this window.

The *.smnt file contains a definition of the SediMeter network, for the purpose of real

time monitoring. The SediMeters listed here will be polled during monitoring. If one of

them is not on the network a time-out error will result. If a SediMeter on the network is not

listed here, it will not get polled.
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Front panel objects

SediMeter List

This is an 1D table that you can navigate through using the horizontal scroll bar. In the

right-most position you see the next unused position, where you can make a new entry.

NetAddr

The NetAddr of a SediMeter on the network.

East/Long (optional)

The easting or longitude of this SediMeter.

North/Lat (optional)

The northing or latitude of this SediMeter.

Units

The units for East/Long and North/Lat. The options are

degrees and meters.

Datum & Projection

A free text description of the projection parameters

associated with East/Long and North/Lat.

GET button

Reads the NetList from the attached instrument and updates the SediMeter List

accordingly. The coordinates are not affected.

SET button

Writes the NetList in the attached instrument based on the NetAddr values in the SediMeter

List. The coordinates are not copied.

ROLL CALL button

This button queries each of the possible 255 NetAddr values, and updates the SediMeter

List. If a SediMeter in the list does not respond, it is removed; if one responds that was not

in the list, it is added to it; and finally the list is sorted in NetAddr order. Newly added

NetAddr entries get coordinates (0,0).

Use this feature to automatically edit the list, and to verify that all units communicate.
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Menus

File menu

Open…  Ctrl+O

Opens a *.smnt file that you choose. Use this and the Save Copy As… commands to

maintain records of different networks on the same computer.

Save  Ctrl+S

Saves the data to the file C:\Lindorm\SediMeter\SM_Network.smnt (provided C: is the

Windows startup volume).

Save Copy As…

Saves a copy of the data to a file and path you select.

Close  Ctrl+W

Closes the window (but leaves the data in memory).

Edit menu

Cut, Copy, and Paste work as previously described.

Delete All

Deletes all entries in the SediMeter List (but leaves Units and Datum intact).

Window menu

As previously described.

Help menu

As previously described.

Change Units window

This window allows for changing the display units for

the analog (optional) sensor channels. For example, if

pressure is measured in the SI unit, Pa, this window can

be used for converting the pressure to depth in meters

based on the normal atmospheric pressure and the

density of the water.
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Front Panel Objects

Unit Changes in Analog Channels

This is an array of clusters. You can define any number of unit changes, but if you define

several changes for the same unit, only the first record will be used. The value is converted

according to the equation y = a + bx.

To delete an individual record, right-click on that record and select Delete Element from

the pop-up menu.

Replace

The unit that you want to replace, padded with space to a length of 3 characters.

With

The characters that should appear instead in the data.

by Multiplying With

The multiplication factor, b in the equation.

and Adding

The constant, a in the equation.

Menus

The menus have minimal functionality. The only File menu option is to close the window.

In the Edit menu, apart from the ubiquitous Cut, Copy, and Paste options there is an option

to Delete All.

SediMeter Data window

This window is the main human interface for the data. The same window is used for

presenting pre-recorded data and for real time monitoring.

Front panel objects

SediMeter NetAddr control

This control selects from which instrument to plot data. Even if the data file only contains

data from one instrument it might be necessary to use this control to load the data.

SediMeter Backscatter Intensity graph

This graph shows the SediMeter data with time on the X-axis, OBS detector on the Y-axis,

and signal level as color. The color scale is indicated on the Z-scale ramp to the right of the

graph itself.



Lindorm Inc. LINDORM.COM

SOFTWARE MANUAL 2.0.DOC 2009-05-06 PAGE 22 OF 37

The color scale is editable. Move the mouse over a scale marker (e.g., 1.250). When the

cursor changes to a double arrow you can drag the scale marker up or down. You can also

right-click it and change its color. If you drag from the end markers you get new

intermediate points.

Out-of-range values are as a default red on the negative side, and yellow on the positive

side. Left-click those fields to change the out-of-range colors. To indicate 0 FBU as out-of-

range, set the lower limit to 1 by selecting the 0 and typing 1 instead.

In the top margin of the window the number of samples is shown.

Reset button

Resets the color scale of the Z-scale ramp to the default.

SediMeter Variable control

Use this control to select which parameter to plot in the intensity chart. The options for data

of firmware rev. 2 are as follows:

Item Meaning Range

Uon voltage with the IR LED on 0–2.5 V

FBU Formazin Backscatter Units 0-65535 FBU

PPM PPM = a * FBU^q (a and q are the PPM coefficients) any

PPM coefficients control

These coefficients are used to estimate the sediment concentration in PPM according to the

following equation:

! 

PPM = a "FBU
q

The values of a and q have to be determined empirically for each specific case. The default

coefficients are just examples that may give results that are off by an order of magnitude.

Bottom Definition control

This control tells the software what to use as the definition for bottom. It operates on the

variable that currently is selected by the SediMeter Variable control. Its range corresponds

to the Z-scale ramp range.

Maneuver the control by dragging the slider, by clicking along the slider, by clicking

the blue arrows in the digital field, or by typing in a value in the digital field. As you move

the control the interpreted bottom Level in the Data Plot graph updates interactively.

Compare the shape of the interpreted Level with your visual interpretation of the bottom in

the SediMeter Backscatter Intensity graph.

Graph controls

A number of controls are common for two or more graphs. They are explained here.
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Graph cursor

The two large graphs have graph cursors. One cursor is defined for each graph in a light

yellow field (the cursors are named “A”). To the right of the cursor name and icon there are

columns for the cursor’s current X position, Y position, and in the case of the intensity

graph, the Z value at that point.

If the cursor is not visible in the graph, right-click the cursor (+) in the cursor control

and select “Bring to Center”. To be able to drag the cursor in the chart, make sure the

cursor symbol (+) is selected in the Graph Palette (see below). You can also move the

cursor by clicking on the diamond-shaped controls to the right of the cursor control.

The cursor for the line graph will snap to a line. Right-click on the cursor in the cursor

control to bring up the context-sensitive menu and select which line to snap to.

Side note: The data derives from an experiment in which a 2000 FTU suspension was left to settle during 12 hours. A
concentration of 1000 FBU was chosen to illustrate the Level detection (cf. Data Plot graph). Concentrations of over 9000

FBU were measured near the bottom. Selecting a higher level, such as 3000 FBU, would give a bottom level that first
increased and then decreased again under steadily increasing below-bottom FBU values. This behavior is thought to
correspond well to how natural cohesive sediments behave.

Graph Palette

In the top or bottom right corner of each graph there is a palette with three choices; cursor,

magnifying glass, and a hand for dragging. The magnifying choices are, from left to right
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on the first line: Zoom in in both dimensions, zoom in in the X dimension, zoom in in the Y

dimension. On the second line: Fit all data to the graph, zoom in to the point of clicking,

zoom out around the point of clicking.

Changing X and Y axis scales

The X-axes all have auto scale as default. To be able to zoom in in the X dimension, you

must first turn off auto scaling. Right-click on the graph or on the X-axis to bring up a

menu where you can turn off “AutoScale X.”

The intensity graph has manual scaling on the Y-axis, from 0 to 36. If you happen to

change the scale and want to restore it, simply select the lowest value and type in 0, then

select the highest value and type in 36. Click in a neutral part of the window to exit edit

mode and enter the changes.

The Data Plot has double Y-axes. To turn AutoScale on or off on either one of them you

must right-click on one of the scale values of the scale in question.

Other features

You can change the legend color, line type etc., and edit the names in the legend.

The intensity chart can be exported as an image by using the Copy Data command in

the context-sensitive menu. The exported image includes all items that presently are visible.

You may wish to turn off the Graph Palette and the Cursor Legend prior to copying the

image. You do that by bringing up the context-sensitive menu (right-click) and de-select

them under Visible Items.

The other graphs can be exported as a simplified image (better for including in a report)

in a similar way.

Each graph also has a Scale Legend, although it is off as default. The scale legend

provides a graphical user interface for setting AutoScale, to scale-to-data once, and for

accessing menus for changing a number of settings of the graphs. To turn it on, right-click

the graph and select Visible Items -> Scale Legend.

The line graphs have an Annotation feature. Right-click on a line to bring up a context-

sensitive menu with Create Annotation as one choice. After you have created it you can

change its color and other attributes. This may be used for marking in the graph when

certain things happened, such as taking a calibration reading with another method.

Data Plot

This graph plots temperature, turbidity, and bottom level. If the sensors are present for it, it

may also plot depth, (visible) light, period, and standard deviation, where the latter two are

estimates based on burst samples.

The level is estimated based on the SediMeter Variable and Bottom Definition presently

selected. There is a possibility to manually edit spurious data points, in the Bottom Level

pane (see below).

The turbidity is estimated as the median of the top 6 OBSes. This variable is plotted on

the right hand side Y-axis. By right-clicking the symbol of a variable in the legend, the Y-

axis on which it is plotted can be changed.
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Bottom Level

This is a 1D list of interpreted bottom level in cm. The index is the record number, starting

at 0. As long as the button is green and says AUTO, the automatic bottom tracing function

is active. Clicking the button so it turns blue and reads MAN turns off the automatic

feature. Changes in SediMeter Variable and Bottom Definition will have no effect on the

bottom curve when this is set to MAN. In this setting the values for each individual point

can be edited so as to remove erroneous values caused by artifacts in the data.

Note that if you click the MAN button and change to AUTO mode, you loose all

manual edits. If you wish to save them, do so before going back to Auto (see export method

below).

Export Data tab

This tab contains a table with data. It is essentially the same data as in the Data Plot graph,

but with battery voltage added.

SAVE button

Click the Save button for saving a tab-delimited ASCII file with the data in the Export Data

table.

3D View tab

This tab contains an Active X control showing a 3D view of the SediMeter backscatter

data. The variable shown is the one presently selected by the SediMeter Variable control

(see above).

Dragging with the mouse changes the point of view. Dragging with the Alt key

depressed zooms in and out. Dragging with the Shift key depressed pans the image.

NOTE: This control is very processor-intensive. If there are many records in the file

you should be careful to click on this tab since it may make the entire window

unresponsive, which means that it may be difficult to click the Export Data tab to the

foreground again.

Burst Samples

The two smaller graphs in the bottom of the window are for optional sensors. Select which

one to display using the control Sensor, and unit using the control Units. Select which

measurement to plot with the control Sample. The indicator Start Time will show the time

when the measurement started.

Burst Samples – Time Domain

This graph shows the measured value over time.

Burst Samples – Frequency Domain

This graph shows the power spectrum of the signal (V2
rms). The estimated frequency of peak

power is shown below the graph, along with the estimated power of that peak.
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Calculation: The measured signal is passed through a 2nd order Butterworth lowpass

filter, followed by a 7-term B-Harris time domain window, and an auto power spectrum

function.

Controls and indicators for real-time monitoring only

Clock

In real-time monitoring there is a clock showing computer date and time in the top center of

the window.

Log File control

In the middle part of the right edge of the window there is a group of 4 objects related to

real time monitoring. The Log File path control field gets its initial value from the Save to

File field under the Monitoring tab in the SediMeter Control window. It is also possible to

change the value in this window, either by writing or using the browse button.

Save to File control: Green LED

When the window opens the logging to file is off. Click the leftmost of the

three LEDs over the Log File field to turn logging on or off.

Monitoring indicator: Green LED

The central of the three LEDs is an indicator for monitoring. To turn off

monitoring, use the Monitoring menu.

Timing Error indicator: Red LED

The rightmost of the three LEDs is a warning for timing error. This turns red if the

application is unable to issue a Measure Now-command in time.

Timing errors can occur for several reasons, including not using a sufficiently large

Interval in relation to the burst sampling and the number of instruments on the network.

Another reason for timing errors may be that the computer has been busy with some

other process, whether caused by the operating system, the user, or something else. Note

that this application is multi-threaded, and that the user interface and the monitoring run as

different processes, why it benefits from being run on a dual-core computer.

If the SediMeter does not respond in time an error is generated, with a dialog. This may

happen if the SediMeter List contains a NetAddr of a SediMeter that is not connected, or

which for some other reason has stopped responding.

Menus

File menu

Export…

This item is not active.



Lindorm Inc. LINDORM.COM

SOFTWARE MANUAL 2.0.DOC 2009-05-06 PAGE 27 OF 37

Close…  Ctrl+W

Closes the window. This item is not active during an ongoing monitoring. First stop the

monitoring (in the Monitoring menu). The window will not close until the present

monitoring loop has finished, the duration of which depends on the interval you have set (if

you have a very long interval you may be better of quitting the application in the SediMeter

Control window rather than waiting for this).

Edit menu

Cut, copy, and Paste work as previously described.

Sinusoidal Interpolation

When this is checked the bottom level is interpolated using a sinusoidal function between

sensors. When cleared, the interpolation is linear.

Monitoring menu

This menu has one item. It reads Off and is dimmed in post-processing mode. It reads On

and is active and selected in real time monitoring mode.

On/Off

To turn off monitoring, de-select this item. Note that the application carries out 2 more

measurements before stopping logging, so it may take up to 2 times the measurement

interval before the window is done.

When you turn off monitoring the File -> Close item becomes operable. However, if

you select Close before monitoring has finished, the window will stay open but

unresponsive until all processes related to it are terminated (between 1 and 2 measurement

intervals).

Map menu

Network…

This opens the Map of SediMeters window (see below).

Interpolate…

This item is currently not active.

Window menu

The content is as previously described.

Help menu

The content is as previously described.



Lindorm Inc. LINDORM.COM

SOFTWARE MANUAL 2.0.DOC 2009-05-06 PAGE 28 OF 37

Map of SediMeters window

This window contains a single object, a map showing the relative position of the

SediMeters in the network. The positions are those entered in the SediMeter List window

(if no coordinates are entered, the map will be empty as in this example).

Click OK to close.
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Advanced Functions
These windows and functions are not for operators but for system designers, integrators,

third party developers, and calibration engineers.

SediMeter Calibration Coefficients window

This window is for editing the calibration coefficients used in firmware rev. 1. Since this is

a largely obsolete feature in firmware rev. 2, this window has been slimmed down and now

it only contains a list of calibration coefficient records. The values are read at program start

from the file “C:\Lindorm\SediMeter\SM_Calibrations.smcc”.

To access this window, select Advanced > Calibration File in the Edit menu of the

SediMeter Control window.

Front panel objects

SediMeter Calibration Coefficients table

Use the horizontal scroll bar at its base to change record. Each record consists of a cluster

of the following data:

NetAddr

The NetAddr of the instrument. The value of the RS485 ID in the instrument must match

this value.

Instrument Identifier

A free text identifier of the instrument (since the NetAddr is subject to change). The system

ignores this text.

Valid From

This calibration coefficient record will not be used for measurements before this date and

time.

Valid To

This calibration coefficient record will not be used for measurements after this date and

time. If you re-calibrate, set an end-date of the old record equal to the start date of the new

one.

36 coefficients K, A, B, C

A 2D table of calibration coefficients. The lower index selects column, the upper one

selects row. Row index 0 corresponds to OBS #1.

Coefficient K is the factor used to convert the corrected voltage to FBU [ca 7000].
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Coefficient A is the signal level in volt when the LED is on and the instrument is

deployed in clear water, with no ambient IR light, and no reflector within several

decimeters [ca 0.26].

Coefficients B and C are used for correcting for background light. Unless the instrument

is deployed very near the surface, this

correction is not even needed. To turn off

this adjustment set B=1 and C=0.

6 coefficients D

Coefficient D is the signal level in volt

when the LED is off and there is no

ambient IR light present (that is, the

background level in darkness). There are

only 6 of these since the 36 OBSes are

divided in 6 groups. D[0] is used for OBS

#1, #7, #13, #19, #25, and #31, while D[1]

is used for OBS # 2, #8, etc. This value is

typically around one to a few mV, and zero

may be an acceptable approximation in

most cases.

Analog Conversion, Channels A6 and
A7

This is a 1D table with 2 entries, one for

each channel of optional sensors in the

analog-to-digital converter. Channels A6

and A7 measure a voltage in the range 0 V

– 2.5 V. The sensor signal can be

connected directly to the A/D input, or via

the OP-AMPs that are provided on the

LogDator PCB.

Equation Type control

Five equations are available:

Polynomial, exponential, Pressure NTC,

and RH. The first two are generic, the remainder are intended for specific sensors. For more

information turn on context-sensitive help and move the mouse over the field.

Coefficients A..F control

The meaning of these coefficients depends on the equation chosen. Refer to the context-

sensitive help.
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Quantity (Unit) control

The symbol of the quantity followed by the real world unit of the value after conversion.

This value will appear in the data display controls, legends, and column headers. You may

type in any text you like.

Menus

File menu

Open…  Ctrl+O

Use this for opening another calibration file than the default one (the file

C:\Lindorm\SediMeter\SM_Calibrations.smcc, assuming C: is the Windows volume, is

opened automatically on application launch). The file to open must be of type  *.smcc.

Save  Ctrl+S

Saves the calibration table to file. If the File indicator field is empty, it gets saved to the

default location (C:\Lindorm\SediMeter\SM_Calibrations.smcc), otherwise it gets saved to

the file in the File field.

Save As…

Opens a browser allowing the calibration table to be saved under a new name or in a new

location. The full path will appear in the File field after the save, and become the target of

future Save commands.

Close  Ctrl+W

Closes the window. The calibration coefficients remain in memory, but not the KABC table

data (it gets repopulated with default values each time the window is opened).

Edit menu

The Cut, Copy, and Paste items function as previously described.

Window menu

The content of this menu is as previously described.

Help menu

The content of this menu is as previously described.

Recalibrate Instrument window

When selecting this option a password window first appears. This is to allow access to only

those having received training in calibration procedures, and prevent unauthorized

manipulation.
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The window shown here has been populated with data

for illustration purposes. Three fields of 8 ASCII

characters each are defined as part of the communication

protocol: Manufacturer, Model, and Serial Number. These

values cannot be changed in the instrument. The rest of

the message contains instrument-specific data.

Front panel objects

For SediMeters and LogDators the instrument-specific data consists of calibFlags (16 bits),

ADdelay (the value of which depends on the speed of the optional analog sensors), offset

and slope (the temperature

sensor calibration), and Umult

(the voltage calibration). After

this follows 5 arrays that each

contain 36 values, one for each

optical backscatter detector. K

is the multiplier, the slope, for

converting to FBU. A is the

value in clear water, and D is

the zero-offset  of the

measurement system. B and C

are factors for discounting

ambient light.

The last block contains

settings for the two optional

sensors. The conversion

algorithm allows for a linear

conversion with two different

k inds  o f  t empera tu re

compensation. The Format byte

specifies the fix format of the

data returned from the

instrument. Conceptually one

can think of the data as

containing only the mantissa

part of a float number, while

this byte contains the exponent

that is common to all values.

The 7-bit hexadecimal value

indicates how many integer bits

the data word contains. Bit 7, if

set, indicates that the data words are signed values. The Units specifies the units of the data.

The NetAddr control and NetAddr in Reply indicator corresponds to the SEnd To

control and Reply From indicator in the control window.



Lindorm Inc. LINDORM.COM

SOFTWARE MANUAL 2.0.DOC 2009-05-06 PAGE 33 OF 37

Menus

File menu

The calibration settings can be saved to file, and the file opened again for later use. This

allows the use of different calibration settings for the same instrument. One possible

application is to calibrate the sedimeter sensor both with and without a holder tube.

To close the window, select Close from the File

menu.

Edit menu

Read Calibration Settings downloads the settings

from the connected instrument and populates the

window. To upload data and change the calibration

settings in the instrument, select Write Calibration

Settings > Re-Program Instrument.

Calibrate menu

This menu contains wizards for calibration.

Although it is possible to edit the values directly in

this window, it may be difficult or impossible to

determine the correct value to enter. That is where

the wizards come in.

General Settings Wizard

This not yet available wizard assists in setting the

flags of calibFlags, as well as ADdelay and Umult.

Temperature Wizard

This wizard assists in determining the optimal values of offset and slope (see below).

SediMeter Wizard

This wizard assists in determining the optimal values of K, A, B, C, and D (see below).

Analog Channel Wizard

This not yet available wizard assists in setting the Analog Sensor Calibration Coefficients.

Window, Help menus

These function as previously described.
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Temperature Wizard window

This window has no menu since it is intended for immediate use. To calibrate the

temperature sensor the following steps should be taken:

1. Let the instrument acquire the same temperature as a precision thermometer.

2. Connect the instrument using RS-485.

3. Turn off optional samples.

4. Go to this window.

5. Click Measure.

6. Copy the result from

the  X (b i t s )

indicator to a line

in the X (bits)

control.

7. T y p e  i n  t h e

temperature of the

precision

thermometer in the

Y (ºC) control.

8. Repeat steps 5 to 7 for additional calibration points if desired.

9. Click Calculate.

10. Verify that the Best Linear Fit corresponds to the Y values.

11. Click OK to close the window and keep the new Offset and Slope.

Alternatively, click Cancel to close the window without saving the values.

Calibration Wizard window

This window opens after selecting SediMeter Wizard in the Recalibrate Instrument

window.

Front panel objects

SediMeter Data table control

This table contains measurements. It can be populated by importing values from a

previously saved text file, by carrying out measurements in real time, or manually. It has 3

dimensions, where Value corresponds to columns, Detector Index to rows, and

Measurement to pages.

Raw data control

This is located below the left column of the data table, and should be set it the column

contains Uoff data rather than data converted using the calibration settings of KABCD.
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FTU table control

For each measurement the true turbidity value shall be entered in the FTU table. The

background light value does not have to be entered, since that is handled automatically.

Estimate control

Select the degree of complexity in the fit. As a minimum A and D are estimated, which

corrects for the background reflection in each detector but does not convert the values to

the formazin standard. Selecting K, A, D converts the values to FBU, formazin backscatter

units. B and C are first-degree and second-degree corrections for ambient light,

respectively. Except in very shallow water they are redundant.

Required Data indicator

This indicates what measurements will be required. These LEDs, as well as those under the

KABCD table, turn on and off in response to changes the user makes in the Estimate

control.

KABCD indicator table

This table shows the new values for the coefficients after calibration.
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Pink field

This allows for the calibration of one detector at a time. The detector # is the value printed

on the sensor itself (range 1 – 36), while index corresponds to the Detector Index of the

SediMeter Data table (range 0 – 35). The Calibrate button estimates the coefficients for that

detector. The curve fit is shown in the diagram and the R2 value is shown in the Rsquare

indicator. If there is an error the circular indicator turns red.

Blue field

The Batch Calibrate button estimates coefficients for all the detectors. If there is no error

the OK button becomes available. If there is an error the error array below the Batch button

can be used to identify the detector with the error.

The OK button closes the window and copies the data to the Recalibrate window, while

Cancel discards the data.

Menus

File > Import Text File...

A text file with measurement data exported from the *sm3 file window can be opened

using this menu choice.

Edit > Measure Now

This triggers an immediate measurement. The data is added to the next free record of the

data table.

Edit > Delete This Measurement

Deletes the currently shown record in the data table.

Edit > Delete All Measurements

Clears the data table.

Monitor Communication Port window

The purpose of this window is to monitor the traffic on an RS-485 network where one

instrument is in master mode and the others in slave mode. The traffic is displayed in

hexadecimal code to the left, and as ASCII characters to the right.

The first 4 bytes are the message header. In the center these 4 bytes are decoded,

although the checksum is analyzed so a value of 00 indicates a valid checksum. The

indicator turns green for valid, and red for invalid checksum.

The window can operate in two modes, continuous and one shot. In continuous mode it

replaces the content as soon as a new message is received. In one-shot mode it displays the

latest message until it is rearmed. When the rectangle is green and reads Listening it is

waiting for new traffic.
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When the rectangle is red and reads Rearm it is keeping the last message displayed. It is

still receiving messages in the background, queuing them until the rearm button is pressed.

One can thus step through the messages one by one.


